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EPA Research Programme 2021–2030 

Guidelines on the Preparation of Final Reports 

Introduction 
 

This document provides general guidance for authors on the preparation of the EPA Research Reports 
that are required for projects funded under the EPA Research Programme 2021-2030. 
 

Please read this document carefully prior to submitting your EPA Research Report to the EPA. 

This document does not replace, but is complimentary to, the: 

1. EPA Research Call Technical Description documents 

2. EPA Research Call Guides and Terms and Conditions for Support of Grant Awards 

 

The above documents are available to download from the EPA’s Online Grant Management and 
Application Portal or from the Call Documents page on the EPA Website. 
 
 

More Information 
 

For further information or assistance please contact research@epa.ie. 
 

Disclaimer  
 
Although every effort has been made to ensure the accuracy of the material contained in this  
publication, complete accuracy cannot be guaranteed. The Environmental Protection Agency, the  
authors and the steering committee members do not accept any responsibility whatsoever for loss or  
damage occasioned, or claimed to have been occasioned, in part or in full, as a consequence of any  
person acting, or refraining from acting, as a result of a matter contained in this publication. Any  
opinions, findings or recommendations expressed in this report are those of the authors and do not  

reflect a position or recommendation of the EPA. All or part of this publication may be reproduced  
without further permission, provided the source is acknowledged.  
 
This report is based on research carried out/data from 2023 to April 2024. More recent data may  
have become available since the research was completed. 
 
The EPA Research Programme addresses the need for research in Ireland to inform policymakers  
and other stakeholders on a range of questions in relation to environmental protection. These reports  
are intended as contributions to the necessary debate on the protection of the environment.

https://epa.smartsimple.ie/s_Login.jsp
https://epa.smartsimple.ie/s_Login.jsp
https://www.epa.ie/publications/research/current-call-documents/
mailto:research@epa.ie
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Final Reporting Requirements 

The Environmental Protection Agency (EPA) requires the Lead Applicant to submit a draft EPA Research 
Report to describe the objectives, methodologies, outcomes, etc. of the research. It is important that all 
lead and co-applicants agree and sign-off on the content of the reports prior to submission to the EPA.  

 

EPA Research Reports should be concise, accessible and non-technical report (c. 20- to 30-page long). In 
the case where a Final Technical Report is also being prepared, the requirements laid out in this 
document should be followed. 

 

All reports should be submitted before the end date of the project, in accordance with the guidelines 
outlined in this document. 

 

Reports must be submitted in MS Word format using the EPA Research Report Layout Template 
which is  available to download from the EPA website. 

 

 

Report Content 

The report should provide a concise, plain English account of the research and should: 

 

• Provide full account of the work completed by the project. 

• Describe the objectives, methodologies, outcomes etc. of the research. 

• Include a short summary demonstrating the relevant findings of the project in relation to 
policy questions and/or legislation. 

• Outline key messages for policy-makers and the public. 

• Include a short Executive Summary (abstract) of a maximum of 700 words. 

 

Authors will also need to prepare summary text for the back cover of the report, under the following 
headings: 

 

• What did the research aim to address? (maximum 180 words). 

• What did the research find? (maximum 180 words). 

• How can the research be used? (maximum 180 words). 

 

 

IMPORTANT: An EPA Research Report will not be considered to have been submitted to the EPA if 
it has not been submitted via the EPA’s Grant Management and Application Portal. 

https://www.epa.ie/publications/research/final-report-guidance/epa-research-report-layout.php
https://epa.smartsimple.ie/s_Login.jsp
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Peer Review 

The draft report will be peer-reviewed and should be revised by the project team to address any 
comments. In case of disagreement, justification should be provided to the EPA explaining why the 
changes recommended were not completed. Revised reports should be submitted to the EPA within 
21 days of receiving the comments. 

 

 

Publication 

If suitable for publication, the EPA will send the EPA Research Report for copy-editing, typesetting and 
proofreading. All comments and queries from the copy-editor and typesetter must be responded to by 
the report author(s) within 28 days. 

 

On completion of the production process the report will be sent for publication on the EPA website as 
an EPA Research Report. 

 

The authors are responsible for the proofing and formatting of any Final Technical Reports as these will 
not to be published by the EPA. Where the Grantee has a website, they should publish the Final 
Technical Report on their website. 

 

 

Open Data 

The EPA Research Programme funds not-for-profit research intended to generate knowledge for 
public good purposes and as such the EPA expects that outputs and/or findings should be widely 
disseminated and made publicly available. 

 

Click here to view our Open Access Policy on the EPA website. 

 

It is a requirement that Lead Applicant to make the final report (whether published on the EPA 
website or not) and any significant datasets available on the EPA's SAFER-data Archive or another 
data repository as agreed by the EPA. 

 

NB: The authors are responsible for the proofing and formatting of reports, datasets and other 
project outputs uploaded to all data repositories. 

https://www.epa.ie/our-services/research/epa-research-2030/strategies-and-policies/open-access-policy/
https://www.epa.ie/our-services/research/epa-research-2030/strategies-and-policies/open-access-policy/
http://eparesearch.epa.ie/safer
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Formatting Guidelines 

All reports must be submitted in MS Word format using the EPA Research Report Layout Template 
which is available to download from the EPA website. The following formatting should be observed 
when preparing the report: 

 

 

Page Layout 

• The paper size (found on the Layout tab) should beset to A4. 

• All figures and tables inserted in the document should fit on an A4 page. 

• The margins (found on the Layout tab) should be set to Normal. 

• Pages should be numbered. 

 

 

Font Styles 

Headings should be formatted as follows: 

 

• Level 1 headings – Calibri 18 pt bold. 

• Level 2 headings – Calibri 12 pt bold. 

• Level 3 headings – Calibri 11 pt bold italics. 

• Level 4 headings – Calibri 11 pt italics. 

 

The main body text within the report should be Calibri 11 pt regular and 1.5 line spacing should be 
used. 

 

Use bold font for emphasis (do not use underlining, italics or inverted commas (‘ or “) for emphasis), 
and emphasise text only where necessary. 

 

 

Alignment, Paragraphs and Line Spacing  

• All text to should be left-aligned (ragged right). 

• Use 1.5 line spacing for the main body text. 

• Leave one clear line space above and below headings and between paragraphs. 

• Do not indent paragraphs. 

https://www.epa.ie/publications/research/final-report-guidance/epa-research-report-layout.php
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Adding Equations 

IMPORTANT – PLEASE NOTE: 

 

The Equation Editor function can cause compatibility issues across different versions of Word. These 
issues can prevent users from being able to download or open Word documents which contain 
equations, or from being able to view equations within the document. 

 

To prevent this: 

 

1. When using the Equation Editor function you will need to take a screenshot of the equation, 
paste the image into the document, and then delete the original Equation Editor object. 

2. If mathematical and/or scientific symbols are included within the document text or within 
tables, you must use the Insert Symbols option and embed fonts (see the sections in this 
document entitled Inserting Symbols and Embedding Fonts for guidance). 

 

 

Inserting Symbols 

When using mathematical and/or scientific symbols in your report you should use the Insert Symbols 
option. To add a symbol, click on the Insert tab, and select the Symbol option.  

 

Most symbols will be available within a subset of normal text, however selecting a different font and 
subset will provide further options: 

 

NB: When inserting symbols, you should always embed the fonts in your document to ensure 
they will be visible to other users. 
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Embedding Fonts 

All fonts should be embedded in the report before it is submitted to the EPA for review to ensure they 
will be visible to readers. The following steps outline the process for embedding fonts into a Word 
document: 

 

1. With the Word document open, click on the File tab in the top left-hand corner of the 
screen and select the Options button. 

2. Click on the Save tab in the Word Options pop-up box. 

3. Locate the heading Preserve fidelity when sharing this document, then select the Embed fonts 
in the file tick box. 

4. Click on the OK button. 

5. Save the document. 
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Style Guidelines 

Prose 

The writing style should be clear and concise, and the report should be written in plain English. Define 
any scientific or technical terms which may be unfamiliar and include a glossary if necessary. 

 

English spellings and grammar styles should be used. For example, use: 

 

• organisation, not organization 

• have got, not have gotten 

 

Do not use the first-person plural. Use ‘The study found…’ or ‘The researchers found…’ not ‘We 
found…’. 

 

 

Abbreviations 

Standard abbreviations should be used, and where necessary abbreviations should be defined. Do not 
use punctuation in acronyms (e.g. use EPA, not E.P.A.) . 

 

 

Hyphens 

Use hyphens in sentences only where necessary for clarity (e.g. six-monthly meetings has a different 
meaning to six monthly meetings). 

Use hyphens in words only where appropriate (e.g. re-mark has a different meaning to remark). 

Use hyphens to connect adjectival expressions (e.g. up-to-date information) 

 

 

Measurements and Scientific Units  

The Metric System should be used for all measurements. 

Any scientific units used should, where possible, be those adopted in the Système International (SI) 
convention. 

There should be a consistent way of referring to units i.e. mg/l or mg l–1   throughout the report 
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Equations 

Equations should be placed on a new line and should be numbered by chapter in parentheses to the 
right of the equation. 

 

Example: 

 
(1.1) 

 
 

 

 

Tables and Figures 

Tables 

All tables must be cited in the text and numbered consecutively in the order in which they are first 
mentioned. Tables should be numbered by chapter, e.g. the first table in chapter one should be 
numbered Table 1.1. 

 

Table titles should contain the table number at the start followed by the description. Each table 
column must have a heading and units should be included where applicable.  Footnotes can be used 
to indicate the source of data in table or to explain abbreviations. 

 
Example: 
 

Table 1.1 - Caption goes here 

 

Title Column 1 Heading Column 2 Heading 

First Row 1.234 L 2.345 ml 

Second Row 9.876 L 8.745 ml 

 
 

Figures 

All figures must be cited in the text and numbered consecutively in the order in which they are first 
mentioned. Figures should be numbered by chapter, e.g. the first figure in chapter one should be 
numbered Figure 1.1. 

 

A caption should be placed below each figure. The caption should include the figure number followed 
by the description.  Where possible the figure should stand alone so that it can be understood without 
reference to the text. 

 

  

IMPORTANT: The Equation Editor function can cause compatibility issues across different versions 
of Word. Please refer to the section in this document entitled Adding Equations for guidance. 
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Example: 

 

Figure 1.1 - Caption goes here 

 

 

 

References 

All references cited in the text must be listed in the References section and a bibliography should be 
used if it contains references that have not been cited in the text. 

 

The Harvard style of referencing should be used. References should be listed alphabetically by the 
name(s) of the author(s), and then chronologically (where there is more than one reference by the 
same author(s)). 

 

Journal titles should be written out in full and the title of articles (or chapters, where applicable) 
should be included. Page ranges for articles should include the start and end pages (e.g. 12 – 15). 

 

Example (journal):  

Beyer, K.M.M., Kaltenbach, A., Szabo, A., Bogar, S., Nieto, F.J. and Malecki, K.M., 2014. 
Exposure to neighbourhood green space and mental health: evidence from the Survey of the 
Health of Wisconsin. International Journal of Environmental Research and Public Health 11: 
3453–3472. 

 

Example (book): 

Butterfield, J., Bingham, S. and Savory, A. 2006. Holistic Management Handbook. Healthy 
Land, Healthy Profits. Island Press, Washington, DC. 

 

Example (book chapter):  

Caffrey, J.M., 1987, Macrophytes as biological indicators of organic pollution in Irish rivers. In: 
Richardson, D.H.S. (Ed.) Biological Indicators of Pollution. Royal Irish Academy, Dublin, Ireland, 
pp. 71–81. 

 

Example (report): 

Bruen, M., Rymszewicz, A., O’Sullivan, J., Turner, J., Lawler, D., Conroy, E. and Kelly -Quinn, M., 
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2017. Sediment Flux – Measurement, Impacts, Mitigation and Implications for River 
Management in Ireland. Environmental Protection Agency, Johnstown Castle, Ireland.  

 

Example (Government and EU publications):  

CEC, 1992. Directive 92/43/EEC, of 21st May, on the Conservation of Natural Habitats and of 
Wild Fauna and Flora. Commission of the European Communities. Official Journal of the 
European Union L206 22.7.1992. 

 

Example (website): 

References to websites should contain enough information to enable to reader to retrieve it.  
EPA (Environmental Protection Agency), 2014. Secure Archive for Environmental Research 
Data. Available online: http://erc.epa.ie/safer/index.jsp (accessed 4 April 2018) 

 
 

Permission to Reproduce Material  

As the author you are responsible for obtaining permission to reproduce copyrighted material (e.g. 
figures, tables, maps and text) from the relevant copyright holder. You should submit copies of the 
copyright licences to the EPA along with your final report.  

 

You should be aware that some publishers can charge a fee for the reproduction of copyrighted 
material. 

 

Even if you are the author of the work being reproduced, you may not necessarily own the copyright 
for the published material. Please check with the publisher.  

 

When applying for permission to reuse copyrighted material, please seek permission for the 
following: 

• worldwide distribution; 

• use in print and/or electronic delivery platforms in any and all media now known or hereafter 
developed; and 

• use in all languages. 

 

In addition, note that the following limitations in copyright licences are not acceptable: 

• restricting electronic/digital use of the EPA report; 

• the time that the EPA may use the copyrighted material; and 

• the countries in which the EPA report may be distributed. 

 

  

http://erc.epa.ie/safer/index.jsp
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Material requiring permission 

The following list details the usual material that you will need to obtain permission to use in your EPA 
report (please note that this is not an exhaustive list and, if in doubt about whether or not you should 
seek permission, it is always best to err on the side of caution and contact the publisher you wish to 
use material from): 

• a single quotation or several short quotes from a full-length book of over 300 words; 

• a single quotation of over 50 words from another a journal, newspaper or magazine article; 

• a quotation of any length from a website; 

• charts, tables or graphs or other representations where the author is using the entire piece of 
work or has used a substantial amount of material from another piece of work; 

• Ordnance Survey maps, map extracts and redrawn maps; 

• photographs; 

• reproduction of web pages or screenshots; 

• logos and trademarks; 

• certain photographs containing recognizable people; 

• reproduction of advertisements; 

• any third-party software used in a CD, DVD or website supporting an author’s work; 

• film stills and film grabs; 

• video clips; 

• audio files; 

• quotations from informal writings, such as speeches, interviews, mission statements, 
questionnaires, classroom discussions or student works. 

 

If the data are presented in a different way in charts, tables, graphs and figures, permission is not 
needed, but the source should be credited. If a table or figure has been adapted, you will need to use 
your judgement as to how different your adaptation is from the original. If in doubt contact the 
original publisher. 
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Using material published by a scientific, technical and medical (STM) publisher  

Science, technical and medical (STM) publishers, participating in the STM Permissions Guidelines (see 
www.stm-assoc.org/intellectual-property/permissions/permissions-guidelines/), will  grant  permission to 
another STM publisher (or its author) without charge for  the following material: 

• up to three figures (including tables) from a journal article or book chapter; 

• up to five figures (including tables) from a whole book or journal issue; 

• up to 30 figures from a single publisher; or 

• a single quotation less than 400 words/or several shorter quotations from the same the same 
book or journal less than 800 words. 

 

Note that the use of maps is not covered by the STM agreement. 

The majority of STM publisher signatories continue to require that a permissions request is made in 
order to monitor how their material is being used. Please do this in all cases where needed. 

 

 

Orphan works 

Orphan works are published material that are still in copyright, but the copyright owners cannot be 
found – even after a diligent good faith search – in order to grant permission to reproduce substantial 
parts of the material. 

 

In the case of orphan works, it is essential to demonstrate that serious effort has been made in good 
faith to locate and contact the rights owner before any use of the material be made. There should be a 
clear and adequate attribution to the orphan work in the text of the report and the use can only ever 
be on a ‘non-exclusive’ basis. If the copyright owner appears in due course, they will be entitled to 
demand the removal of their material or demand an appropriate fee for the use of their work. 

 

If the rightsholder is a small publisher, then the following sources may be helpful for identifying 
rightsholder contacts: 

• in the UK, the Publishers’ Licensing Services (www.pls.org.uk/);  

• in the UK, the Authors' Licensing and Collecting Society (ALCS) (http://www.alcs.co.uk); 

• in the USA, the Copyright Clearance Center (www.copyright.com/); or 

• for other international publishers, the International Federation of Reproduction Rights 
Organisation (www.ifrro.org/rro). 

 

 

Credit your source 

To avoid any accusations of plagiarism (specifically self, paraphrasing, verbatim and mosaic) you 
should always provide a source and credit for any copyright material used. In most cases, the original 
publisher's rights department or the journal’s editorial office will advise you of the exact form of 
words required. This usually includes a full bibliographic reference to the original publication and an 
acknowledgement that the material is reproduced with permission from the rights owner.  

http://www.stm-assoc.org/intellectual-property/permissions/permissions-guidelines/),
http://www.pls.org.uk/)%3B
http://www.copyright.com/)%3B
http://(www.ifrro.org/rro
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Graphs, Charts and Images 

To ensure high-quality print reproduction, all graphs, charts, and images embedded in the Word 
document should also be supplied separately with clearly labelled filenames, to the specification 
below: 

 

Exporting VECTOR File Formats - Suitable files: 

• Adobe Illustrator - EPS/PDF/AI 

• Corel Draw - EMF/EPS/PDF 

• Visio - EPS 

• Excel /PowerPoint /Word – PDF 

 

 

Exporting BITMAP File Formats - File formats accepted: 

• TIFF 

• JPEG 

• PSD 

• BMP 

 

 

NB: All Bitmap images must be at a minimum of 300 dpi at A5 size (or 2000 pixels on the 
shortest side). 
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Checking for Compatibility Issues 

Before you submit your report to the EPA for review it is recommended that you check for potential 
compatibility issues with other versions of Word. 

 
To do this: 

 
1. Select the File tab 

2. Click on the Check for Issues button in the Inspect Document section 

3. Select the Check Compatibility option – this will open the Compatibility Checker pop-up 

 
Potential compatibility issues will be displayed in the Summary section. By clicking on the Select 
versions to show button you can choose which version of Word to compare – narrowing the selection 
to the most recent versions may reduce the number of issues found. 

 
In the following examples a reduction in the number of potential issues is noted when the oldest 
version of Word is excluded from the compatibility check: 
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All  Versions Compared – 14 issues Two Versions Compared – 1 issue 
 

 

NB: It is strongly recommended that as a minimum you check for compatibility issues in Word 
2007 and Word 2010. 
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Pre-Submission Checklist 

 

Pre-Submission Checklist 

Text 

✓ Has been spellchecked, including scientific or technical words which may not be recognised 
by the Word spellchecker 

✓ Capitalisation and abbreviations have been used consistently throughout the document 

✓ Page numbering has been used throughout the document 

✓ Fonts used to add symbols have been embedded in the document 

Headings 

✓ Capitalisation is consistent and correct 

✓ Full-stops have not been used at the end of headings 

Measurements and Scientific Units 

✓ The Metric system has been used 

✓ Have been referred to consistently throughout the document 

Equations 

✓ Have been numbered 

✓ Have been created using symbols, or been added as an image 

✓ Have been embedded in the document 

Tables and Figures 

✓ Are cited in the text 

✓ Are numbered sequentially and labelled/captioned correctly 

✓ Are sufficiently high resolution for print quality 

✓ Axes have been correctly labelled 

References 

✓ Have been cited in the text 

✓ Harvard referencing system has been used 

Reproduced Material 

✓ Permissions to the use the material have been obtained 

✓ Licences/copyright numbers are included in the Acknowledgements section 

Graphs, Charts and Images 

✓ Where required, have been supplied separately in appropriate formats/resolutions 

Compatibility 

✓ The document has been checked for compatibility with other versions of Word 

 


